
GII-01. GEOGRAFINIŲ INFORMACINIŲ SISTEMŲ PAGRINDAI 

 

8 praktinis darbas: GIS rastrinės analizės pagrindai 

 

Atlikimo terminas:  2007 m. rugpjūčio 21d. 

 

Praktinio darbo vertinimas: Šis praktinis darbas vertinamas iki 25 balų, jo vertė sudaro 10 proc. 

viso kurso praktinių darbų bendro pažymio. 

 

 

Aprašymas ir uţdaviniai 

 

Atlikdami šią užduotį išmoksime rastrinių duomenų analizės ir procedūrų pagrindų. Ši analizė visų 

pirma pagrįsta artumo operacijomis ir įrankiais, kurie naudojami, pavyzdžiui, atliekant buferių 

kūrimą, perdangą ir atstumo matavimą. 

  

Atsiskaitymo reikalavimai 

 

Į tolesnius nurodymus įtraukti klausimai parengti taip, kad paskatintų jus apgalvoti kiekvieną 

pratimo veiksmą. Atlikdami pratimą pasistenkite neskubėti, nes dėl to dažnai praleidžiami veiksmai 

ar kyla nereikalingų klaidų. Jei apgalvojate kiekvieną veiksmą ir suprantate, kas vyksta, padarius 

klaidą bus daug paprasčiau ją ištaisyti. Jei padarysite klaidą, atidžiai grįžkite atliktų veiksmų eile 

atgal, kol ją pastebėsite. Labai retai pasitaiko, kad viską reikėtų pradėti nuo pradžių (nebent dirbdami 

pamiršote išsaugoti savo darbą). 

 

Kai baigsite pratimą, atsakykite į tekste pateiktus klausimus. Parašykite trumpą ataskaitą (ne 

trumpesnę kaip 500 žodžių), kurioje aprašykite darbo procesą ir rezultatus. Daugeliu atvejų tuos 

pačius rezultatus galima pasiekti skirtingais būdais, taigi, galite užrašyti pastabas apie alternatyvius 

būdus, jei tokių yra. Nukopijuokite ir įterpkite į ataskaitą klausimus ir atitinkamus atsakymus, tačiau 

šiame darbe naudojamų ekrano nuotraukų ir iliustracijų kopijuoti nereikia (jei yra, pasinaudokite 

kurso ataskaitos šablonu). 

 

Baigę pateikite ataskaitą PDF, RTF arba DOC formatu per BlackBoard nuotolinio mokymo sistemą 

(jei reikia, pridėkite ekrano atvaizdus). 

 

Pasiruošimas 

 

Šiam darbui naudosite Anykščių rajono GIS duomenis. 

Visi pirminiai duomenys saugomi šiuose kataloguose: 

DEM – skaitmeninis vietovės reljefo modelis (SRM) (ESRI geografinės matricos formatas 

(grid)); 

LTDBK50000-V – 1:50 000 mastelio topografinis žemėlapis („shape“ failai). 

AnyksciuDirvozemiai – dalies Anykščių rajono savivaldybės kadastro vietovių dirvožemio 

tipai („shape“ failai); 

 



Pirmuosius du katalogus jau turite pateiktame DVD Nr.1 ir turėtumėte būti įsikėlę į savo kompiuterį 

(C:\Data\). AnyksciuDirvozemiai katalogą su duomenimis, kuris pateikiamas per BlackBoard 

nuotolinio mokymo sistemą, nukopijuokite į C:\Data\. 

 

Šio darbo metu sukursite išvestinius duomenis, todėl paruoškite šiam darbui katalogą ir pavadinkite 

jį GII01_8 (visas kelias: C:\Data\GII01_8). 

 

Dėmesio! Šiam darbui sukurkite pradinių duomenų kopijas ir naudokite jas, o ne originalius 

duomenis. 

 

UŢDUOTIS 
 

Kaip pradedantysis ūkininkas pageidaujate įsigyti žemės pakankamai didelės apimties 

gyvulininkystės veiklai. Rajone (dalyje kadastro vietovių) norite surasti vietas su tinkama dirva ir 

atvira pietine puse, kuriose būtų galima auginti pašarus gyvuliams. Kadangi rūpinatės aplinka, norite 

žinoti, ar potencialiose vietose fermoms yra upių ir (ar) vandens telkinių, nes norite apsaugoti 

vandenis nuo žemės ūkio nuotekų ir gyvulių paliekamos taršos.  

 

Ideali vieta fermai turėtų tenkinti tokias sąlygas: 

 

 ekspozicija: (pietinė – vertinama 3 balais (aukščiausiai), pietryčių – 2 balai, arba pietvakarių 

– 1 balas),  

 dirvožemio tipas: (sunkūs dirvožemiai, saugantys nuo teršalų skverbimosi į gruntinius 

vandenis – 1 balas); 

 atstumas nuo vandens: > 200 metrų (1 balas) statyti fermai ir auginti pašarus gyvuliams. 

 

Pradiniai duomenys 

 

 Upės iš 1:50000 mastelio topografinių žemėlapių. 

 Dalies Anykščių rajono savivaldybės dirvožemiai atskiruose „shape“ failuose kiekvienai 

kadastro vietovei. 

 Skaitmeninis viso Anykščių rajono reljefo modelis. 

 

Strategija 

 

1. Sukurti šlaito ekspozicijos sluoksnį iš SRM ir nustatyti minimalius atstumus nuo upių. 

2. Sujungti atskirus dirvožemių „shape“ failus į vieną Anykščių rajono dirvožemio sluoksnį. 

3. Transformuoti dirvožemius iš vektorinio („shape“ failas) į rastrinį formatą (geografinės 

matricos failai). 

4. Perdengti šlaito ekspozicijos (aspect), atstumo nuo upių ir dirvožemių sluoksnius, gaunant 

žemėlapių sankirtą. 

 



 

Darbo eiga 
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A ETAPAS. DUOMENŲ PARUOŠIMAS 

 

1 veiksmas. Leidţiamas erdvinės analizės (Spatial Analyst) plėtinys ir nustatoma darbinė 

aplinka 

 

Paleidţiama ArcMap (Start > Programs > ArcGIS > ArcMap) su nauju tuščiu žemėlapiu. 

Įrankių > plėtinių (Tools > Extensions) meniu paţymėkite laukelį ties erdvinės analizės 

(Spatial Analyst) plėtiniu ir uždarykite (Close) dialogo langą. 

Įtraukite erdvinės analizės (Spatial Analyst) įrankių juostą į ArcMap naudotojo sąsają: 

vaizdas > įrankių juostos > erdvinės analizės plėtinys (View > Toolbars > Spatial Analyst) ir 

paţymėkite laukelį ties erdvinės analizės plėtinio (Spatial Analyst) punktu. Įrankių juosta 

įtraukiama į ArcMap sąsają. 

 

2 veiksmas. Naudodami reljefo šešėliavimą (Hillshade) sukurkite trimatį foną 

 

Norėdami sukurti patrauklų žemėlapio foną, iš dviejų sluoksnių, reljefo (nustato spalvą) ir kalvų 

šešėlių (nustato šviesumą) generuosite sudėtinį atvaizdavimą. 

Pridėkite skaitmeninį Anykščių rajono reljefo modelį (geografinės matricos failą), jei prašoma, 

sukurkite piramidę. 

Pervadinkite į SRM. 

Pakeiskite atvaizdavimo spalvas: 

Sluoksnio atvaizdavimo spalvas pakeisti nesudėtinga, ir bendriems duomenims pateikiamos 

specializuotos spalvų paletės. 

Dukart spragtelėkite SRM sluoksnį, kad atidarytumėte sluoksnio savybių (Layer 

Properties) langą. 

Ekrano (Display) skyrelyje įveskite ‘30’% skaidrumą (transparency). 

Kad pamatytumėte poveikį, spragtelėkite taikyti (Apply). 

Simbolikos (Symbology) skyrelyje pasirinkite dviejų atspalvių spalvų paletę (pvz., nuo 

rudos iki žalios) ir paţymėkite invertavimo (Invert) laukelį. 

Spragtelėkite Ok. 

Vaizdui suteikite gilumo efektą: 

Iš erdvinės analizės (Spatial Analyst) įrankių juostos: 

Padarykite SRM sluoksnį aktyvų. 

Iš erdvinės analizės > paviršiaus analizės > kalvų šešėlių (Spatial Analyst > Surface 

Analysis > Hillshade) pasirinkite kalvų šešėlius (Hillshade): 

Patvirtinkite numatytąsias kalvų šešėlių (Hillshade) parametrų reikšmes. 

Spragtelėkite Ok.  

SRM sluoksnio kalvų šešėliai (Hillshade) bus įtraukti į turinį (Table of Contents). 

Nutempkite SRM kalvų šešėlių (Hillshade of SRM) sluoksnį po SRM sluoksniu. 



Dukart spragtelėkite SRM kalvų šešėlių (Hillshade of SRM) sluoksnį, kad atidarytumėte 

sluoksnio savybių (Layer Properties) langą. 

Simbolikos (Symbology) skyrelyje pakeiskite išplėtimo tipą (Type of Stretch) į standartinį 

nuokrypį (Standard Deviation). 

Spragtelėkite Ok. 

Išsaugokite projektą. 

 

3 veiksmas: Atskirų dirvoţemio failų sujungimas (dalis Anykščių rajono savivaldybės) 

 

Pirminiai dirvožemio duomenys apima tą Anykščių rajono savivaldybės dalį, kuri domina ūkininką. 

Tačiau dirvožemio duomenys yra suskirstyti į atskirus failus pagal kadastro vietoves, taigi, turi būti 

sujungti į vieną bendrą sluoksnį. 

Atskirų dirvožemio sluoksnių sujungimas į vieną sluoksnį: 

Pridėkite vieną po kito kiekvienos kadastro vietovės dirvožemio sluoksnius (konturas.shp) ir 

turinyje pervadinkite kiekvieną sluoksnį skirtingu pavadinimu. 

Sujunkite visus dirvožemio sluoksnius į vieną bendrą sluoksnį (naudokite sujungimo 

(Merge) įrankį iš ArcTool įrankių skydelio > duomenų valdymo įrankių > bendrojo (ArcTool 

Box -> Data Management Tools -> General) meniu). 

Išsaugokite gautą sluoksnį darbiniame kataloge kaip Soil „shape“ failą. 

Pašalinkite pirminius dirvožemio sluoksnius iš žemėlapio. 

 

4 veiksmas. Duomenų transformavimas (iš elementų į rastrą): Anykščių rajono dirvoţemiai 

 

Transformuokite vektorinius dirvožemio duomenis iš poligoninio „shape“ failo į geografinės 

matricos formatą, kuris tinka erdvinei analizei panaudojant Spatial Analyst. Yra dvi elementų 

transformavimo į rastrą priežastys: galite analizuoti juos kartu su kitais rastrais ir galite jiems taikyti 

visas Spatial Analyst priemones. 

 

Prieš transformuodami duomenis turite nustatyti analizės ypatybes. Šie parametrai apibrėžia 

generuojamos geografinės matricos, kuri gaunama su duomenimis atlikus atitinkamą operaciją, 

charakteristikas. 

 

Spatial Analyst meniu spragtelėkite pasirinkčių (Options) punktą ir įveskite tokius parametrus: 

Bendrųjų pasirinkčių (General) skyrelyje: Nustatykite rastro darbinį katalogą (Working 

directory for raster): savo darbinį katalogą. 

 Nurodykite analizės šabloną (Analysis mask): SRM. 

Aprėpties (Extent) skyrelyje:  Nurodykite analizės aprėptį (Analysis extent): tokią pat kaip 

SRM sluoksnio (Same As Layer “SRM”). 

Gardelės dydžio (Cell Size) skyrelyje:  Nustatykite analizės gardelės dydį (analysis cell size): 

tokį pat kaip SRM sluoksnio (Same As Layer “SRM”). 



Spragtelėkite OK. 

Dirvožemio (Soil) elementų sluoksnio transformavimas į rastrą: 

Pridėkite dirvožemio (Soil) sluoksnį į ArcMap žemėlapį (pridėti duomenis (Add Data)  

mygtuku). 

Erdvinės analizės (Spatial Analyst) meniu pasirinkite transformuoti > elementą į rastrą (Convert 

> Feature to Raster). Parametrus užpildykite taip: 

 Įvedami elementai (Input Features): Soil. 

 Laukas (Field): PAVCOMP1 

Išvedamas rastras (Output raster): soilgrid (pastaba: pavadinimai negali būti ilgesni kaip 14 

simbolių ir negali turėti taškų „.“ arba tarpų). 

Spragtelėkite OK (Naujas sluoksnis bus įtrauktas į žemėlapį). 

Suskleiskite soilgrid legendą (spragtelėkite  ir pakeiskite į ). 

Pašalinkite iš žemėlapio pirminį dirvožemio (Soil) elementų sluoksnį. 

 

 

5 veiksmas. Pridėkite upių sluoksnį: rivers_l 

Pridėkite upių (rivers_l) sluoksnį į ArcMap žemėlapį: spragtelėkite pridėti duomenis (Add 

Data)  mygtuką ir pasirinkite upes (rivers_l). 

Spragtelėkite pridėti (Add) (jei prašoma, sukurkite piramides).  

Spragtelėkite Ok, jei bus įspėjimas apie trūkstamą georeferencinę informaciją. 

Atidarykite upių sluoksnio savybių (Properties) langą, dukart spragtelėdami ant sluoksnio 

pavadinimo turinyje.  

Simbolikos (Symbology) skyrelyje pakeiskite sluoksnio simbolių spalvą į šviesiai mėlyną. 

Paspauskite Ok. 

Išsaugokite žemėlapio dokumentą. 

 

 

B DALIS: VIETOS TINKAMUMO ANALIZĖ 

 

Šio etapo metu žemėlapyje turi būti rodomi tokie sluoksniai: 

 

1. SRM ir SRM kalvų šešėlių (Hillshade of SRM) (geografinė matrica); 

2. rivers_l („shape“); 

3. Soilgrid (geografinė matrica). 

Dabar visi duomenys paruošti vietos tinkamumo analizei. 

 



6 veiksmas. Pagal SRM sukurkite šlaito ekspozicijos sluoksnį 

 

Ekspozicija (Aspect) yra šlaito orientacija arba kryptis pagal kompasą. Ekspozicijos reikšmė nurodo 

besileidžiančio šlaito rastrinės gardelės kryptį jos kaimynų atžvilgiu. Ekspozicija matuojama pagal 

laikrodžio rodyklę laipsniais nuo 0 (šiaurės ekspozicija) iki 360 (vėl šiaurės ekspozicija, apėjus visą 

apskritimą). Kiekviena ekspozicijos matricos gardelės reikšmė rodo kryptį, į kurią atsisukęs šlaitas. 

Plokšti šlaitai neturi ekspozicijos, ir jiems suteikiama reikšmė -1. 

 

Pirmasis mūsų žemės tinkamumo žemės ūkiui analizės veiksmas bus nustatyti laukus, kurių didžioji 

dalis pasvirusi pietų kryptimi, kad leistų sėkmingai auginti pašarinius augalus. Norėdami 

apskaičiuoti ekspoziciją: 

Erdvinės analizės (Spatial Analyst) meniu pasirinkite paviršiaus analizę > ekspoziciją 

(Surface Analysis > Aspect); 

įveskite tokius parametrus: 

įvesties paviršius (Input surface): SRM. 

Spragtelėkite Ok. Turinyje (Table of Contents) pasirodys naujas sukurtas SRM ekspozicijos 

(Aspect of SRM) sluoksnis. 

Dabar turime nagrinėjamos teritorijos ekspozicijos sluoksnį. Kitas veiksmas bus nustatyti, kokios 

teritorijos atitinka mūsų poreikius: 

 
Pietūs:   159.444 – 199.556   geriausia ekspozicija 

Pietryčiai:  119.333 – 159.444   antra ekspozicijos kategorija 

Pietvakariai:  199.556 – 239.667   trečia ekspozicijos kategorija 

 

7 veiksmas. Ekspozicijos sluoksnio perklasifikavimas 

 

Perklasifikavimas naudingas modeliuojant tinkamumą, kai būtina priskirti pasirinkimo, jautrumo 

arba prioritetų reikšmes. Dabar galite perklasifikuoti slankaus kablelio SRM ekspozicijos (Aspect of 

SRM) matricos sluoksnį į sveikųjų skaičių matricos sluoksnį, suklasifikuodami jo reikšmes pagal 

grupes. Padarysime tai, kad sukurtume tinkamos ekspozicijos kategorijų sluoksnį. 

Erdvinės analizės (Spatial Analyst) meniu pasirinkite perklasifikuoti (Reclassify). 

Jei dar nepasirinktas, kaip įvesties paviršių (Input surface) pasirinkite Aspect of SRM. 

Spragtelėkite perklasifikavimo (Reclassify) dialogo klasifikavimo (Classify) mygtuką. 

Pakeiskite klasių skaičių į 9.  

Spragtelėkite OK. 

Įveskite tokias naujas reikšmes, surinkdami jas naujų reikšmių (New Values) stulpelyje: 
Iš     Į  

-1 – 39.111   Nėra duomenų (NoData) 

39.111 – 79.222  Nėra duomenų (NoData) 

79.222 – 119.333  Nėra duomenų (NoData) 

119.333 – 159.444  2   (antra ekspozicijos kategorija) 

159.444 – 199.556  3   (geriausia kategorija) 

199.556 – 239.667  1   (trečia ekspozicijos kategorija) 



239.667 – 279.778  Nėra duomenų (NoData) 

279.778 – 319.889  Nėra duomenų (NoData) 

319.889 – 360   Nėra duomenų (NoData) 

Išsaugokite pertvarkymo lentelę kaip suaspect.info failą darbiniame aplanke. 

(Perklasifikavimo (Reclassify) dialogo lange spragtelėkite „išsaugoti“ (Save)). 

Spragtelėkite OK reikšmių perklasifikavimo (Reclassify Values) dialoge. 

Išvedamas rastras (Output raster): SuAspect  

Spragtelėkite OK. 

Pašalinkite originalius SRM, SRM kalvų šešėlių (Hillshade of SRM) ir SRM ekspozicijos 

(Aspect of SRM) sluoksnius. 

Išsaugokite projektą. 

 

 

8 veiksmas: Sukurkite tinkamo dirvoţemio ţemėlapį (išskyrimas pagal atributus) 

 

Toliau sukursite dirvožemių žemėlapį pasirinkdami tinkamų dirvožemio tipų teritorijas. 

Kad būtų tenkinami pasirinkimo reikalavimai, jums reikia sunkaus dirvožemio, kuris riboja teršalų 

prasisunkimą į gruntinius vandenis. Pagal TDV-96 dirvožemio klasifikavimo sistemą dirvožemio 

tipo santrumpa rodoma kodo pradžioje, o kodai po pasvirų brūkšnių (/) žymi dirvodarines uolienas 

(/s yra smėlis, /ps yra priesmėlis, /p yra priemolis, /d yra durpės). Pagal šią kodų sistemą /p, /p1 ir 

/p2 reiškia tokią pat dirvodarinę uolieną, tačiau 2 yra sunkesnė už 1, ir taip toliau. Mūsų pratimo 

tikslas nėra išsami dirvožemio analizė, taigi, pratimui pasirinksime dirvožemio tipus, kurių 

išsamiuose kodiniuose pavadinimuose yra eilutės fragmentas /p/p. 

Atidarykite  ArcToolbox įrankių skydelį spragtelėję jo parodymo ir paslėpimo piktogramą  , jei 

skydelis dar nėra atidarytas. 

Išskleiskite erdvinės analizės įrankius (Spatial Analyst Tools) ir jų išskyrimo priemonių rinkinį 

(Extraction toolset). 

Dukart spragtelėkite išskyrimo pagal atributus (Extract by Attributes) įrankį. Įveskite šiuos 

parametrus: 

Įvesties rastras (Input raster): soilgrid 

Sąlyga „kur“ (Where clause): "PAVKOMP1" LIKE '%p/p'  

„Kur“ sąlygos dešinėje esančiame duomenų įvesties laukelyje  naudojama SQL funkcija, 

apibrėžianti užklausą. 

 

Simboliams naudokite tokias pat kaip lentelėje didžiųjų ir mažųjų raidžių sąlygas. 

 

Išsaugokite užklausą kaip susoil.exp failą darbiniame kataloge, kad galėtumėte ją panaudoti dar 

kartą. (Užklausų konstruktoriaus (QueryBuilder) dialoge spragtelėkite „išsaugoti“ (Save)). 

Spragtelėkite Ok. 

 



Turinyje pasirodys nauja geografinė matrica su įvairiomis reikšmėmis, kurios tenkina /p/p kriterijų ir 

atitinka dirvožemių tipus, kuriuos išskyrėte iš soilgrid. Kadangi išskirtoje dirvožemio geografinėje 

matricoje yra tik tinkami dirvožemiai, mums nebūtina rodyti dirvožemio tipų reikšmių. Dėl to mes 

perklasifikuosime jį į vieną tinkamumo klasę. 

Erdvinės analizės įrankių juostoje (Spatial Analyst Toolbar) spragtelėkite extract_soil, kad 

jis taptų aktyviu sluoksniu. 

Erdvinės analizės (Spatial Analyst) meniu pasirinkite perklasifikuoti (Reclassify). 

Susiraskite didžiausią ir mažiausią diapazono reikšmes. 

Įveskite tokias reikšmes, surinkę jas naujų reikšmių (New Values) stulpelyje 

Senos reikšmės     Naujos reikšmės  

Mažiausia_reikšmė – didžiausia_reikšmė  

(Minimum_value – Maximum_value)  1 

Nėra duomenų (NoData)    Nėra duomenų (NoData) 

Ištrinkite visas kitas reikšmes (norėdami pažymėti ir ištrinti įrašų grupę galite laikyti 

nuspaudę Shift klavišą). 

Išsaugokite pertvarkymo lentelę kaip susoil.info failą darbiniame kataloge pakartotiniam 

naudojimui. (Perklasifikavimo (Reclassify) dialogo lange spragtelėkite „išsaugoti“ (Save)). 

Pavadinkite išvedamą rastrą (Output Raster) SuSoil. 

Spragtelėkite OK perklasifikavimo (Reclassify) dialoge. 

Pašalinkite pirminius soilgrid ir extract_soil sluoksnius. 

Išsaugokite projektą. 

 

9 veiksmas: Apskaičiuokite atstumą nuo vandens objektų (tolydų atstumą) 

 

Sukursime tolydaus atstumo nuo vandens objektų geografinės matricos temą. Išvesties laukeliams, 

kuriuose yra vanduo, suteikiama nulinė reikšmė. Šios tolydaus atstumo matricos temą panaudosime 

surasti teritorijas, esančias 200 metrų atstumu nuo vandens objektų. 

Erdvinės analizės (Spatial Analyst) meniu pasirinkite atstumą > tiesi linija (Distance > 

Straight Line). 

Įveskite tokius parametrus: 

Atstumas iki (Distance to): rivers_l 

Išvesties gardelės dydis (Output cell size): 50 

Distance to rivers_l sluoksnis pasirodys turinyje. Šis sluoksnis rodo atstumo nuo vandens 

kategorijų skaičių. 

Perkelkite rivers_l sluoksnį turinyje aukštyn, kad jis būtų braižomas virš atstumo iki upių 

(Distance to privers_l) temos. 

 



10 veiksmas: Suraskite vietas, esančias pakankamai toli nuo upių 

 

Jūsų tikslas yra surasti potencialias naujų fermų vietas, šalia kurių 200 metrų atstumu nėra vandens. 

Kad išskirtume šią teritoriją, turėsime perklasifikuoti (Reclassify) Distance to rivers_l sluoksnį. 

Erdvinės analizės (Spatial Analyst) meniu pasirinkite perklasifikuoti (Reclassify). 

Įveskite tokius parametrus: 

Įvesties rastras (Input Raster): Distance to rivers_l. 

Susiraskite didžiausią ir mažiausią diapazono reikšmes. 

Pakeiskite šiuos parametrus, surinkdami juos senųjų reikšmių (Old Values) ir naujųjų 

reikšmių (New Values) stulpeliuose: 

Iš      Į 

0–200     Nėra duomenų (NoData) 

200 – (įveskite maksimalią reikšmę) 1 

Nėra duomenų (NoData)  Nėra duomenų (NoData) 

Pašalinkite visus kitus įrašus (norėdami pažymėti ir ištrinti įrašų grupę galite laikyti 

nuspaudę Shift klavišą). 

Išsaugokite pertvarkymo lentelę kaip sudist.info failą darbiniame kataloge. 

(Perklasifikavimo (Reclassify) dialogo lange spragtelėkite „išsaugoti“ (Save)). 

Išvedamas rastras (Output Raster): SuDist 

Spragtelėkite OK perklasifikavimo (Reclassify) dialoge. 

Pašalinkite iš turinio pirminius rivers_l ir Distance to rivers_l sluoksnius. 

Išsaugokite projektą. 

Sukūrėte žemėlapio sluoksnį, rodantį daugiau kaip 200 metrų nuo esamų vandenų esančias 

teritorijas. 

 

11 veiksmas: Visų ţemėlapių perdanga siekiant rasti tinkamą visus kriterijus atitinkantį 

sklypą 

 

Sukūrėte sluoksnius, rodančius tinkamą ekspoziciją, dirvožemį ir atstumą nuo vandens. Dabar jūsų 

tikslas yra naudojantis šiais suklasifikuotais geografinės matricos sluoksniais surasti potencialias 

vietas naujai fermai. Kad tai atliktumėte, sudėsite šias geografines matricas ir parengsite jungtinį 

geografinių matricų žemėlapį. 

Kad sukurtume sąlygą, kuri suformuos naują rezultato matricos sluoksnį, pasinaudosime rastro 

skaičiuotuvo (Raster Calculator) dialogu. Ši išraiška gali remtis vienu arba keletu geografinių 

matricų sluoksnių. 

Erdvinės analizės (Spatial Analyst) meniu pasirinkite rastro skaičiuotuvą (Raster 

Calculator): 

Dukart spragtelėkite [SuDist] sluoksnį slankiajame sluoksnių (Layers) sąraše, kad 

įtrauktumėte jį į skaičiavimą. 



Paspauskite „+“ aritmetinį operatorių. 

Dukart spragtelėkite [SuSoil] sluoksnį slankiajame sluoksnių (Layers) sąraše. 

Paspauskite „+“ aritmetinį operatorių. 

Dukart spragtelėkite  [SuAspect] sluoksnį slankiajame sluoksnių (Layers) sąraše. 

Galutinė išraiška bus: ([SuDist] + [SuSoil] + [SuAspect]) 

Paspauskite „įvertinti“ (Evaluate). 

Naudodamiesi sluoksnio savybių (Layer Properties) dialogu pervadinkite (Rename) naująjį 

sluoksnį į (SuLand). 

 

Išsaugokite projektą. 

 

Sukūrėte geografinę matricą, kuri rodo iš trijų įvesties sluoksnių sukauptą vertinimą. Didesnis 

įvertis rodo geresnes vietas fermai statyti. 

 

 

1 klausimas. Išsaugokite rezultatus kaip ArcMap dokumentą, o programos langą kaip PDF failą 

(pasirinkite tinkamą vaizdo mastelį, geriausiai parodantį jūsų gautus rezultatus). Ataskaitoje 

parašykite trumpą savo darbo aprašymą, pateikite gauto žemėlapio ekrano nuotrauką. Jei reikia, 

kaip ataskaitos priedą pridėkite skaitinius rezultatus (6 balai). 

 

2 klausimas. Kaip galutinėje geografinėje matricoje buvo nusakytos geriausios vietos? (2 balai). 

 

3 klausimas. Kodėl galutinėje geografinėje matricoje matomos tik 3, 4 ir 5 reikšmės? Kas atsitiko 

su kitomis reikšmėmis? Jei jos yra, kodėl nerodomos? Jei jų nėra, kokia konkreti reikšmė 

naudojama tokiais atvejais? (2 balai). 

 

4 klausimas. Kiek yra gardelių, turinčių 3, 4 ir 5 reikšmes? Kokia reikšmė atitinka tinkamiausias 

vietas? Koks yra šių tinkamiausių vietų plotas (hektarais)? (2 balai). 

 

5 klausimas. 200 m zonai apie kiekvieną upę apskaičiuoti naudojome atstumo (Distance) 

operatorių. Kokia konkrečia vektorinės analizės operacija gautumėte tokius pačius rezultatus? 

Koks pagrindinis skirtumas tarp šių operatorių? (4 balai). 

 

6 klausimas. Surašykite ir paaiškinkite pagrindinius rastrinių operacijų tipus. Kokį konkretų tipą 

naudojome šlaito ekspozicijai apskaičiuoti? (2 balai) 

 

7 klausimas. Kas yra žemėlapių algebra ir kur šiame pratime ją panaudojote? (1 balas) 

 

8 klausimas. Kodėl dirvožemių vektorinį sluoksnį (Soil) transformavome į rastrinį sluoksnį? (2 

balai) 

 

9 klausimas. Kas yra erdvinis filtravimas, ir kur bei kam konkrečiai šiame pratime 

rekomenduotumėte jį naudoti? (4 balai) 


